Richard J. Toman
David Lovelock

SARDECK
A Program For Generating Table-Top Exercises for Inland Searches
Preliminary Edition to accompany SARDECK Version 0.12

November 15, 2008

Tucson, Arizona, USA
Preface

Prerequisites
This manual is designed to be used in conjunction with the software SARDECK, which is free and is available for download from www.wcasie.com. It is assumed that the reader (the instructor) is familiar with common Search and Rescue terms, such as POA, ROW, POD, CPOD, and ICS.

Please email any corrections or suggestions to David Lovelock at dsl@math.arizona.edu.

Outline of the Manual
This manual is divided into three parts: Understanding SARDECK, Using SARDECK, and Appendices.

- Part I, Understanding SARDECK starting on page 1, is devoted to explaining every menu item in SARDECK.
- Part II, Using SARDECK starting on page 53, explains how to use SARDECK to create Table-Top Exercises.
- Part III, Appendices starting on page 73, covers material ancillary to the program together with a full index.

Acknowledgments
We would like to thank the following people for their valuable ideas and contributions.

Eric Johnson
Daniel J. O’Connor

We also thank Paul Welter for making his Net-Spell code freely available, which is the basis of our spell checker.

Richard J. Toman
David Lovelock

Tucson, Arizona, USA
Part I Understanding SARDECK

1. Beginning SARDECK ................................................................. 1
   1.1 Installing SARDECK ............................................................. 1
   1.2 Running SARDECK .............................................................. 1
   1.3 Running SARDECK With Minimum Mouse Use ......................... 2

2. An Introduction to SARDECK ................................................... 3
   2.1 History of SARDECK ............................................................ 3
   2.2 Outline of SARDECK ........................................................... 3
   2.3 Starting SARDECK .............................................................. 7

3. The File Menu ........................................................................... 9
   3.1 Overview .............................................................................. 9
   3.2 Start New Deck ................................................................. 10
   3.3 Open Existing Deck ............................................................. 14
   3.4 Rename Deck ..................................................................... 15
   3.5 Export Contents Of Deck Folder .......................................... 15

4. Creating Cards ........................................................................ 16
   4.1 Create/Edit Card For Clue ..................................................... 16
   4.2 Create/Edit Card For Event ................................................... 17
   4.3 Create/Edit Card For Resources ......................................... 18
   4.4 Resource Factoring .............................................................. 29
   4.5 For Instructor ..................................................................... 29

5. Project A Card ......................................................................... 30

6. The Scenario Menu .................................................................. 32
   6.1 Overview .............................................................................. 32
   6.2 Create/Edit Scenario .......................................................... 32
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7. The <em>Images</em> Menu</td>
<td>36</td>
</tr>
<tr>
<td>7.1 Overview</td>
<td>36</td>
</tr>
<tr>
<td>7.2 Image Viewer</td>
<td>37</td>
</tr>
<tr>
<td>8. The <em>Table-Top Exercise</em> Menu</td>
<td>38</td>
</tr>
<tr>
<td>9. The <em>View Exercise</em> Menu</td>
<td>39</td>
</tr>
<tr>
<td>10. The <em>Timeline</em> Menu</td>
<td>44</td>
</tr>
<tr>
<td>11. The <em>Customize</em> Menu</td>
<td>47</td>
</tr>
<tr>
<td>12. The <em>Help</em> Menu</td>
<td>49</td>
</tr>
<tr>
<td>Part II Using SARDECK</td>
<td></td>
</tr>
<tr>
<td>13. How To Add Cards To Exercise</td>
<td>53</td>
</tr>
<tr>
<td>14. How To Use SARDECK</td>
<td>58</td>
</tr>
<tr>
<td>15. An Example Of A Table-Top Exercise</td>
<td>59</td>
</tr>
<tr>
<td>15.1 An Example Of A Scenario</td>
<td>59</td>
</tr>
<tr>
<td>15.2 An Example Of Cards</td>
<td>60</td>
</tr>
<tr>
<td>15.3 An Example Of An Image</td>
<td>61</td>
</tr>
<tr>
<td>15.4 An Example Of A Timeline</td>
<td>62</td>
</tr>
<tr>
<td>15.5 An Example Of A Playbook</td>
<td>62</td>
</tr>
<tr>
<td>16. How To Run A Table-Top Exercise</td>
<td>68</td>
</tr>
<tr>
<td>Part III Appendices</td>
<td></td>
</tr>
<tr>
<td>A. TeX</td>
<td>73</td>
</tr>
<tr>
<td>B. Random</td>
<td>76</td>
</tr>
<tr>
<td>Index</td>
<td>77</td>
</tr>
</tbody>
</table>
List of Figures

1.1 The Menu Key ................................................................. 2
2.1 A SARDECK Scenario .................................................. 4
2.2 A SARDECK Clue ......................................................... 5
2.3 A SARDECK Event ....................................................... 5
2.4 A SARDECK Resource .................................................. 6
2.5 Another SARDECK Resource ......................................... 6
2.6 A SARDECK Timeline ................................................. 7
2.7 The SARDECK Opening Window ..................................... 7
3.1 The File Menu ............................................................... 9
3.2 The For Instructor Menu ............................................. 9
3.3 Start New Deck ........................................................... 10
3.4 The Main Window ....................................................... 10
3.5 The Main Window ....................................................... 11
3.6 The Main Window ....................................................... 12
3.7 The Elements Context Menu ........................................ 12
3.8 The For Instructor Menu ............................................. 13
3.9 Import Cards ............................................................... 13
3.10 The Cards Context Menu ............................................. 14
3.11 Move Card ................................................................. 14
3.12 The For Instructor Menu ............................................. 14
3.13 Open Existing Deck ................................................... 15
3.14 Rename Deck ............................................................. 15
3.15 Export Contents Of Deck Folder .................................... 15
4.1 Create/Edit Clue ........................................................... 16
4.2 Create/Edit Event ......................................................... 18
4.3 Create/Edit Resources-Firefighter ................................. 19
4.4 Random Name ............................................................. 19
4.5 Create/Edit Resources-Firefighter ................................. 20
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.6</td>
<td>The Main Screen</td>
<td>20</td>
</tr>
<tr>
<td>4.7</td>
<td>Random Name</td>
<td>21</td>
</tr>
<tr>
<td>4.8</td>
<td>Create/Edit Resources-Law Enforcement</td>
<td>21</td>
</tr>
<tr>
<td>4.9</td>
<td>Create/Edit Resources-Law Enforcement</td>
<td>22</td>
</tr>
<tr>
<td>4.10</td>
<td>The Main Screen</td>
<td>22</td>
</tr>
<tr>
<td>4.11</td>
<td>Random Name</td>
<td>23</td>
</tr>
<tr>
<td>4.12</td>
<td>Create/Edit Resources-Ranger</td>
<td>23</td>
</tr>
<tr>
<td>4.13</td>
<td>Create/Edit Resources-Ranger</td>
<td>24</td>
</tr>
<tr>
<td>4.14</td>
<td>The Main Screen</td>
<td>24</td>
</tr>
<tr>
<td>4.15</td>
<td>Create/Edit Resources-SAR Team</td>
<td>25</td>
</tr>
<tr>
<td>4.16</td>
<td>Create/Edit Resources-SAR Team</td>
<td>26</td>
</tr>
<tr>
<td>4.17</td>
<td>The Main Screen</td>
<td>26</td>
</tr>
<tr>
<td>4.18</td>
<td>Random Name</td>
<td>27</td>
</tr>
<tr>
<td>4.19</td>
<td>Create/Edit Resources-Town Person</td>
<td>27</td>
</tr>
<tr>
<td>4.20</td>
<td>Create/Edit Resources-Town Person</td>
<td>28</td>
</tr>
<tr>
<td>4.21</td>
<td>The Main Screen</td>
<td>28</td>
</tr>
<tr>
<td>4.22</td>
<td><em>For Instructor</em></td>
<td>29</td>
</tr>
<tr>
<td>5.1</td>
<td><em>Project A Card</em></td>
<td>30</td>
</tr>
<tr>
<td>5.2</td>
<td>The <em>Project A Card</em> Context Menu</td>
<td>31</td>
</tr>
<tr>
<td>6.1</td>
<td>The <em>Scenario Menu</em></td>
<td>32</td>
</tr>
<tr>
<td>6.2</td>
<td>The Scenario Editor</td>
<td>33</td>
</tr>
<tr>
<td>6.3</td>
<td>The <em>File Menu</em></td>
<td>33</td>
</tr>
<tr>
<td>6.4</td>
<td>The <em>Edit Menu</em></td>
<td>34</td>
</tr>
<tr>
<td>6.5</td>
<td>The <em>Tools Menu</em></td>
<td>34</td>
</tr>
<tr>
<td>6.6</td>
<td>The Scenario Skeleton</td>
<td>34</td>
</tr>
<tr>
<td>6.7</td>
<td>The Scenario In Free-Form</td>
<td>35</td>
</tr>
<tr>
<td>7.1</td>
<td>The <em>Images Menu</em></td>
<td>36</td>
</tr>
<tr>
<td>7.2</td>
<td>The Image Viewer</td>
<td>37</td>
</tr>
<tr>
<td>7.3</td>
<td>The <em>File Menu</em></td>
<td>37</td>
</tr>
<tr>
<td>8.1</td>
<td>The <em>Table-Top Exercise Menu</em></td>
<td>38</td>
</tr>
<tr>
<td>8.2</td>
<td>Start New Exercise</td>
<td>38</td>
</tr>
<tr>
<td>9.1</td>
<td>View Exercise</td>
<td>39</td>
</tr>
<tr>
<td>9.2</td>
<td>The <em>View Exercise Menu</em></td>
<td>40</td>
</tr>
<tr>
<td>9.3</td>
<td>The <em>Cards Menu</em></td>
<td>40</td>
</tr>
<tr>
<td>9.4</td>
<td>Add Comment To End Of Exercise</td>
<td>40</td>
</tr>
<tr>
<td>9.5</td>
<td>View Exercise</td>
<td>41</td>
</tr>
<tr>
<td>9.6</td>
<td>Add Image's Filename To End Of Exercise</td>
<td>41</td>
</tr>
<tr>
<td>9.7</td>
<td>The <em>Playbook Menu</em></td>
<td>42</td>
</tr>
<tr>
<td>9.8</td>
<td>The <em>View Exercise Context Menu</em></td>
<td>43</td>
</tr>
<tr>
<td>10.1</td>
<td>Timeline</td>
<td>44</td>
</tr>
<tr>
<td>Figure Number</td>
<td>Description</td>
<td>Page</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>10.2</td>
<td>The Timeline Menu</td>
<td>45</td>
</tr>
<tr>
<td>10.3</td>
<td>Add An Entry</td>
<td>45</td>
</tr>
<tr>
<td>10.4</td>
<td>Timeline</td>
<td>46</td>
</tr>
<tr>
<td>10.5</td>
<td>The Timeline Context Menu</td>
<td>46</td>
</tr>
<tr>
<td>11.1</td>
<td>The Customize Menu</td>
<td>47</td>
</tr>
<tr>
<td>11.2</td>
<td>The Firefighter Submenu</td>
<td>47</td>
</tr>
<tr>
<td>11.3</td>
<td>The Firefighter Ranks</td>
<td>47</td>
</tr>
<tr>
<td>11.4</td>
<td>The Law Enforcement Submenu</td>
<td>48</td>
</tr>
<tr>
<td>11.5</td>
<td>The Ranger Submenu</td>
<td>48</td>
</tr>
<tr>
<td>11.6</td>
<td>The SAR Team Submenu</td>
<td>48</td>
</tr>
<tr>
<td>11.7</td>
<td>The Town Person Submenu</td>
<td>48</td>
</tr>
<tr>
<td>12.1</td>
<td>The Help Menu</td>
<td>49</td>
</tr>
<tr>
<td>13.1</td>
<td>Highlight Clue in the Elements Panel</td>
<td>53</td>
</tr>
<tr>
<td>13.2</td>
<td>The Elements Context Menu</td>
<td>54</td>
</tr>
<tr>
<td>13.3</td>
<td>Instructions</td>
<td>54</td>
</tr>
<tr>
<td>13.4</td>
<td>Empty Boxes</td>
<td>55</td>
</tr>
<tr>
<td>13.5</td>
<td>Two Boxes Checked</td>
<td>56</td>
</tr>
<tr>
<td>13.6</td>
<td>The Table-Top Menu</td>
<td>56</td>
</tr>
<tr>
<td>13.7</td>
<td>Clues Added</td>
<td>57</td>
</tr>
<tr>
<td>13.8</td>
<td>View Exercise</td>
<td>57</td>
</tr>
<tr>
<td>A.1</td>
<td>Clue Cards</td>
<td>74</td>
</tr>
<tr>
<td>A.2</td>
<td>Law Enforcement Cards</td>
<td>75</td>
</tr>
</tbody>
</table>
Part I

Understanding SARDECK
1. Beginning SARDECK

1.1 Installing SARDECK

SARDECK requires that the Windows XP operating system be updated by installing the Microsoft .NET Framework 1.1. You must have Administrator privileges to do this.

You can check to see if the .NET Framework 1.1 is installed by clicking Start on your Windows desktop, selecting Control Panel, and then double-clicking the Add or Remove Programs icon. When that window appears, scroll through the list of applications. If you see “Microsoft .NET Framework 1.1” listed, it is installed. Alternatively, you can check to see if the .NET Framework 1.1 is installed by downloading the file CheckNET.zip from wcasie.com, unzipping it, and running it.

If the .NET Framework 1.1 is not installed, then there are two different ways to install it.

1. **Automatically.** Run Microsoft Windows Update. You will find the free .NET Framework 1.1 under Custom installation (rather than the Express installation). After the .NET Framework 1.1 is installed, you should run Microsoft Windows Update a second time to download the security patch, Service Pack 1, for the .NET Framework 1.1.

2. **Manually.** Download dotnetfx.exe from Microsoft. Running it installs the .NET Framework 1.1. Then download NDP1.1sp1-KB867460-X86.exe from Microsoft. Running it installs the .NET Framework 1.1 Service Pack 1.

Some people have mistakenly downloaded the “.NET Framework SDK Version 1.1”, which is the Software Development Kit and is 106 MB long. You do NOT need this.

To install SARDECK, first download the document InstallSARDECK.zip from www.wcasie.com, and then unzip it and run InstallSARDECK.exe. You will be asked where you want to save the SARDECK files, and whether you want a shortcut created on the Desktop.

SARDECK does not make any changes to your operating system and uninstalls cleanly. It can be run from a hard drive, a zip drive, a thumb drive, or a CD (assuming the files created by SARDECK can be saved to a writable drive).

### Uninstalling SARDECK

To uninstall SARDECK, delete the folder containing the SARDECK files, and delete the shortcut on the Desktop, if installed.

1.2 Running SARDECK

To run SARDECK, either use the shortcut on the Desktop or move to the folder containing the files and select the application SARDECK, that is, SARDECK.exe. Windows must first be updated by installing Microsoft’s .NET Framework 1.1.
Upgrading SARDECK

To upgrade SARDECK, make sure that SARDECK is not running and then download, unzip, and run the program InstallSARDECK.exe to overwrite the old SARDECK files with the upgraded SARDECK files.

Bugs

This is an Alpha version of SARDECK, and, as much as we’d like to believe otherwise, it would be surprising if it does not have bugs. Bugs can come in two varieties:

1. Non-catastrophic ones, but serious, where the wrong numbers are computed or the wrong objects are displayed, for example. In this case please email your observations together with the SARDECK version number to dsl@math.arizona.edu. Thank you.

2. Catastrophic ones, where the program crashes.
   If this occurs, a window will open and a file called “SARDECKBugReport.txt” will appear either on your desktop or in the folder containing “SARDECK.sar”. Please email this text file to dsl@math.arizona.edu. In addition, in the email, please explain what you were doing at the time. Thank you.

1.3 Running SARDECK With Minimum Mouse Use

It is possible to use SARDECK with minimum mouse use. Most menu items have an “accelerator” key, which is indicated by an underlined letter exposed when the “ALT” key is pressed. (It is possible to have these letters permanently underlined in all programs by: right-clicking on any blank area on the desktop, selecting “Properties”, “Appearance”, “Effects”, and deselecting “Hide underlined letters for keyboard navigation until I press the Alt key.”)

To open a context menu, either use “Shift F10” or press the Menu Key, which is usually located on the bottom row of the keyboard, near the right-hand “CTRL” key. See Figure 1.1.

Fig. 1.1: The Menu Key
2. An Introduction to SARDECK

2.1 History of SARDECK

In 1995, Richard J. Toman, the Civilian SAR Administrator for the Commonwealth of Massachusetts, developed a process for generating Table-Top Exercises for inland searches. He created a deck of cards, which he called S.E.T.T.L.E.R.® after “Strategic Educational and Tactical Training for Law Enforcement Resources”. His cards fall into three categories: Clues, Events, and Resources, and his searches are centered in the imaginary town of SETTLER, with imaginary subjects, imaginary residents, and imaginary resources. He also created scenarios in which these cards could be used to construct different Table-Top Exercises, depending on the audience. Over the years Richard has honed these cards, and has run many successful Table-Top Exercises based on them.

In 2008, David Lovelock teamed up with Richard with a view to creating a software program that could generate these cards as well as simplify the process of creating a Table-Top Exercise from them. SARDECK is the result.

2.2 Outline of SARDECK

SARDECK stands for “Search And Rescue: Desktop Exercises from Cards and Know-how”. It helps to create and maintain the Clues, Events, and Resources that support a particular SAR scenario. Then it allows the instructor to select them in any order to construct multiple table-top exercises, each with its own timeline.

When using SARDECK, each Table-Top SAR Exercise comprises six components.

1. A Scenario, which summarizes the initial events on which the Exercise is based.
2. A Deck of electronic cards, which describe possible Clues, Events and Resources that might be found during the exercise.
3. Images, which are associated with the scenario or cards.
4. A Timeline, which describes in time, such items as the subject’s movements, the weather, the start of the search, when clues were left, etc.
5. A Playbook, which is an ordered list of instructions containing such items as the cards, comments, image filenames, reminders, and advice for running the exercise.
6. An associated map with the pertinent locations identified. The instructor supplies this.

The Scenario summarizes the initial events on which the Exercise is based. Figure 2.1 is an example.
The exercise also has a Deck of electronic Cards associated with it. These Cards are divided into three Elements.

1. Clues, which are cards describing possible clues that might be found during the exercise. Figure 2.2 is an example.
2.2 Outline of SARDECK

Fig. 2.2: A SARDECK Clue

CLUE

Mrs. Peters states to the Police dispatcher that she saw Mr. Lewis headed toward the lake this morning at 0500 hrs.

Determine the influence of this clue for search planning.

Fig. 2.2: A SARDECK Clue

2. Events, which are cards describing possible events that might occur during the exercise. Figure 2.3 is an example.

Fig. 2.3: A SARDECK Event

EVENT-RESOURCE RELATED

One of the Big Valley Team has fallen and appears to have broken his femur.

Tell the instructor how this is addressed and what role the IC plays in such an event.

Fig. 2.3: A SARDECK Event

3. Resources, which are cards describing possible resources that might arrive during the exercise. Figures 2.4 and 2.5 are examples.
Chapter 2. An Introduction to SARDECK

RESOURCES-GROUP
Big Valley Search and Rescue. 14 groundpounders have arrived with their own communications base and radio’s. All are good in ground searching and studied under Perkins and Roberts of the UK.
Sign in the members and prepare them for deployment.

Fig. 2.4: A SARDECK Resource

RESOURCES-TOWN PERSON
Name: Mrs. Verna Peters
Affiliation: Citizen
Area of Expertise: Community Affairs
SAR Training: 3
SAR Experience: 3
SAR Equipment: 2
SAR Section: Logistics
Leadership: 5
Organized: 6
Credibility: 6
Good Sense: 5
Reliability: 7
Age: 53
Health: 5
Years of Residence: 53
Employed: No
Employer:
Note: Very active in town. Everybody knows Verna. She serves as a School Board member and is trusted by all.

Fig. 2.5: Another SARDECK Resource
Many skills have a number from 0 to 10, which indicates the resource’s capability to perform a particular skill, where 0 means “None” and 10 means “Outstanding”. This process is called Resource Factoring. See Table 2.1.

<table>
<thead>
<tr>
<th>Skill Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>None</td>
</tr>
<tr>
<td>1</td>
<td>Well Below</td>
</tr>
<tr>
<td>2</td>
<td>Below</td>
</tr>
<tr>
<td>3</td>
<td>Above</td>
</tr>
<tr>
<td>4</td>
<td>Well Above</td>
</tr>
<tr>
<td>5</td>
<td>Outstanding</td>
</tr>
</tbody>
</table>

Having created the Scenario and Deck, an instructor can then generate multiple Table-Top Exercises based on the same scenario and deck. The instructor does this for each exercise by constructing a Timeline that describes the subject’s movements, such as shown in Figure 2.6, based on an appropriate map.

Then the instructor selects cards from the deck that complement the timeline. The instructor can then re-order the cards and add comments, image filenames, reminders, and advice before generating a Playbook.

It is possible for the instructor to either create a personalized scenario, deck, and exercise; or to use someone else’s; or to modify existing ones. Then the instructor can create and run a Table-Top Exercise.

2.3 Starting SARDECK

When the instructor first runs SARDECK, the window shown in Figure 2.7 opens.
There are six main menu items: *File, Scenario, Images, Table-Top Exercise, Customize, and Help.* Subsequent chapters, (Chapters 3–12) will deal with each of these menu items in turn.

Initially the instructor has three options under the *File* menu.

1. **Start New Deck**, which creates a new set of elements.
2. **Open Existing Deck**, which opens a previously saved set of elements.
3. **Exit**, which closes the program.

If the instructor selects **Start New Deck** then he/she is asked to supply a Deck Name and a folder to save the deck. After creating a deck, a file named “SARDECK.sar” is created in that folder and two panels open on the main window. See Figure 3.4 on page 10. The left-hand one, the *Elements* panel, contains the list of *Elements*. The right-hand panel, the *Cards* panel, is empty, but will contain the Cards associated with the elements on the left.

The *Elements* panel has a context menu associated with it, which the instructor can access by right-clicking the mouse when it is over an item. There is also a context menu associated with the *Cards* panel, which is activated once that panel is populated.

---

So shuffle the electronic SARDECK and create a Table-Top Exercise!
3. The *File* Menu

3.1 Overview

There are 11 options under the *File* menu. See Figure 3.1.

- **Start New Deck**, which creates a new Deck. See Section 3.2 on page 10.
- **Open Existing Deck**, which opens a previously saved Deck. The file named “SARDECK.sar” should be opened. See Section 3.3 on page 14.
- **Close Deck**, which closes the current Deck.
- **Rename Deck**, which allows the instructor to rename the current Deck. See Section 3.4 on page 15.
- **View Deck**, which displays the scenario and the collection of cards.
- **Print Deck**, which prints the scenario and the collection of cards.
- **Save Deck To Text File**, which prints the scenario and the collection of cards to a text file.
- **Save All Cards To TeX File**, which creates a TeX file from the collection of cards. See Appendix A on page 73. If the instructor has TeX and the Flashcards macro installed, then all cards can be printed in a professional manner by opening this TeX file.
- **For Instructor**, which opens the submenu shown in Figure 3.2.
  - **View Deck**, which displays the scenario and the collection of cards together with all For Instructor comments.
  - **Print Deck**, which prints the scenario and the collection of cards together with all For Instructor comments.
  - **Save Deck To Text File**, which prints the scenario and the collection of cards together with all For Instructor comments, to a text file.
- **Export Contents Of Deck Folder**, which copies the contents of the current Deck folder to a new location, either for backup purposes, or to use as the basis for a new Deck with its scenario. See Section 3.5 on page 15.
- **Exit**, which closes the program.

Fig. 3.1: The *File* Menu

Fig. 3.2: The *For Instructor* Menu
Each of these menu items is now treated in turn, as warranted.

### 3.2 Start New Deck

When the instructor selects Start A New Deck Figure 3.3 opens and a Deck Name and a Folder to save the deck are required.

Clicking the Folder button allows the instructor to navigate through the folders. If the folder already contains a deck, then the instructor is asked to use a different folder. Each deck must be in its own folder.

After creating a deck, a file named “SARDECK.sar” is created in that folder and two panels open in the main window, as seen in Figure 3.4.
The left-hand one, the Elements panel, contains a list of the following *Elements*, divided into three groups: Clues, Events, and Resources.

- Clue
- Event-External Emergency
- Event-External Influence
- Event-Find
- Event-Investigation
- Event-Logistics
- Event-Management Related
- Event-Medical
- Event-Resource Related
- Event-Search Related
- Event-Weather
- Resources-Firefighter
- Resources-Group
- Resources-Law Enforcement
- Resources-Other

- Resources-Ranger
- Resources-SAR Team
- Resources-Town Person

The right-hand panel, the Cards panel, is empty, but will contain the cards associated with the elements on the left.

The Elements panel has a context menu associated with it, which the instructor accesses by right-clicking the mouse, when it is over an item. The instructor can use this context menu to create a Clue, an Event, or a Resource. See Section 3 on page 12. There is also a context menu associated with the Cards panel, which is activated once that panel is populated. Depending on the element, the columns are sorted either by Description or by Last Name. See Section 3 on page 13.

After a Clue has been added, the instructor will see something like Figure 3.5.
After adding a few more clues, Figure 3.6 is what the instructor might see.

Notice they are in alphabetical order, and that the first one needs editing because it has two spaces after “A”. The instructor can edit this Clue either by double clicking on it, or by highlighting the clue and opening the Cards Context Menu discussed on page 13.

The **Elements** Context Menu

The *Elements* Context Menu exposes 11 options shown in Figure 3.7.
Create Card For Element, which allows the instructor to add a card to the element that is highlighted. The instructor can also access this option by double-clicking on the appropriate element. Depending on the highlighted element the instructor adds a card to a Clue, an Event, or a Resource. See Chapter 4 on page 16.

Select A Random Card From Element, which randomly highlights a card associated with the element that is highlighted. See Chapter 5 on page 30.

Project A Random Card From Element, which randomly projects a card associated with the element that is highlighted. See Chapter 5 on page 30.

Select Cards For Exercise From Element, which, if a Table-Top Exercise (see Chapter 8 on page 38) has been created, places boxes next to the cards, which can then be checked, and are then ready to be added to the exercise.

Select All Cards For Exercise From Element, which, if a Table-Top Exercise (see Chapter 8 on page 38) has been created, places checked boxes next to the cards, which are then ready to be added to the exercise.

View All Cards From Element, which displays all the cards associated with the element that is highlighted.

Print All Cards From Element, which prints all the cards associated with the element that is highlighted.

Save All Cards To File From Element, which prints to a file all the cards associated with the element that is highlighted.

Save All Cards To TeX File From Element, which creates a TeX file from all the cards associated with the element that is highlighted. If the instructor has TeX and the Flashcards¹ macro installed, then these cards can be printed in a professional manner by opening this TeX file. See Appendix A on page 73.

Import Cards To Element, which allows the instructor to import cards to the highlighted element from another deck. While importing, the program checks to see if a specific selected set of fields (such as first name, last name, title, and affiliation) of an imported card are already in the current set of cards, and, if so, does not import it. See Figure 3.9.

Fig. 3.8: The For Instructor Menu

- View All Cards From Element, which displays all the cards associated with the element that is highlighted together with all For Instructor comments.
- Print All Cards From Element, which prints all the cards associated with the element that is highlighted together with all For Instructor comments.
- Save All Cards To File From Element, which prints to a file all the cards associated with the element that is highlighted together with all For Instructor comments.

The Cards Context Menu exposes seven items. See Figure 3.10.

¹ http://www.ctan.org/tex-archive/macros/latex/contrib/flashcards/.
Fig. 3.10: The Cards Context Menu

- **Delete Card**, which deletes the highlighted card from the highlighted element. Before deleting the instructor will be asked to confirm this.
- **Edit Card**, which allows the instructor to edit the details of the highlighted card from the highlighted element. The instructor can also access this option by double-clicking on the appropriate card. Depending on the highlighted element the instructor edits a card from a Clue, an Event, or a Resource. See Chapter 4 on page 16.
- **Move Card**, which allows the instructor to move either a Clue Card or an Event Card from one element to another. It does not allow the instructor to move resource cards. See Figure 3.11.
- **View Card**, which displays the highlighted card from the highlighted element.
- **Print Card**, which prints the highlighted card from the highlighted element. Multiple copies of the same card may be printed.
- **Save Card To File**, which saves the highlighted card from the highlighted element to a text file.
- **For Instructor**, which opens the submenu shown in Figure 3.12.

Fig. 3.11: Move Card

- **View Card**, which displays the highlighted card, together with all **For Instructor** comments, from the highlighted element.
- **Print Card**, which prints the highlighted card, together with all **For Instructor** comments, from the highlighted element. Multiple copies of the same card may be printed.
- **Save Card To File** which saves the highlighted card, together with all **For Instructor** comments, from the highlighted element to a text file.
- **Project A Card**, which opens a new screen displaying the entire contents of the current card. See Chapter 5 on page 30.
- **Copy Name To Clipboard**, which copies the full name and certain other details from some Resource Cards to the clipboard. This is useful if the instructor is creating Events and needs to include the name of a Resource.

3.3 Open Existing Deck

**Open Existing Deck** allows the instructor to open a previously saved Deck. The instructor should open a file named “SARDECK.sar”. See Figure 3.13.
3.4 Rename Deck

Rename Deck gives the instructor the option of renaming the Deck. The name is cosmetic and plays no role in the use of the deck. See Figure 3.14.

3.5 Export Contents Of Deck Folder

Export Contents Of Deck Folder copies the contents of the current Deck folder to a new location, either for backup purposes, or for use as the basis for a new deck with its scenario. Clicking the Folder button allows the instructor to navigate through the folders. See Figure 3.15.
4. Creating Cards

In this chapter we describe how to create and edit the cards, namely Clues, Events, and Resources.

4.1 Create/Edit Card For Clue

This allows the instructor to add (or edit) a Clue card. Clues can be physical (an item, such as a baseball cap, or an event, such as a building being broken into), documentary (a written clue, such as a summit log), or testimonial (statement by others, such as a neighbor or family member might give).

There are two boxes to be completed. See Figure 4.1.

- A Description box where the instructor describes the clue.
- An Instructions box where the instructor inserts the instructions for the participants.

![Create Card For Clue](image.png)

Fig. 4.1: Create/Edit Clue
Both of these boxes accept a maximum of 600 characters.
Each of these boxes can be spell-checked using a rudimentary spell-checker. Avoid using the characters ∼ and |, which SARDECK uses for internal purposes.
The For Instructor button allows the instructor to attach a comment to the card for the instructor’s eyes only. Section 4.5 on page 29.
Sometimes there is no clear cut way of determining whether a card is an event or a clue. Thus, it is possible to Move A Card from one element to another. See Section 3 on page 14.
Pressing Accept saves the resource to disk, and the Clue card shows up on the main screen.

4.2 Create/Edit Card For Event

This allows the instructor to add (or edit) different types of Event cards. These describe possible events that might occur during the exercise. There are 10 types of events. Rather than define each one, we give examples.

- Event-External Influence. Example: A State Representative from the area arrives with 20 members of the press. The Representative is requesting (in front of the media) to know why the search subject has not been found.
- Event-Find. Example: The subject is located sleeping under his grandmother’s bed.
- Event-Investigation. Example: A mother from across town calls to state that her children saw the subject in the back yard about an hour ago.
- Event-Logistics. Example: There is insufficient food to feed the searchers.
- Event-Management Related. Example: Reporters from throughout the state have converged on the search area. Satellite trucks and vehicles are blocking the side roads. Fire Trucks are blocked from accessing the Command Post at this time.
- Event-Medical. Example: A searcher falls and breaks his ankle.
- Event-Resource Related. Example: The communications unit reports that they are unable to contact one of the Teams.
- Event-Weather. Example: The National Weather Service issues a severe storm warning for the search area.

For each of these events there are two boxes to be completed. See Figure 4.2.

- A Description box where the instructor describes the event.
- An Instructions box where the instructor inserts the instructions for the participants.
Both of these boxes accept a maximum of 600 characters.

Each of these boxes can be spell-checked using a rudimentary spell-checker. Avoid using the characters ~ and |, which SARDECK uses for internal purposes.

The *For Instructor* button allows the instructor to attach a comment to the card for the instructor’s eyes only. Section 4.5 on page 29.

Pressing *Accept* saves the resource to disk, and the Event card shows up on the main screen.

Sometimes there is no clear cut way of determining whether a card is an event or a clue. Thus, it is possible to *Move A Card* from one element to another. See page 14.

### 4.3 Create/Edit Card For Resources

This allows the instructor to add (or edit) different types of Resource cards. These describe possible resources that might arrive during the exercise. There are seven types of resources.

- Resources-Firefighter
- Resources-Group. This follows the same pattern as Clues. See page 16.
- Resources-Law Enforcement
- Resources-Other. This follows the same pattern as Clues. See page 16.
- Resources-Ranger
- Resources-SAR Team
- Resources-Town Person

#### Create/Edit Card For Resources-Firefighter

This allows the instructor to add or edit a Firefighter Resource card. See Figure 4.3.

There are various boxes to be completed. In many cases there are drop-down menu items to select from, which can be edited under the menu item *Customize*. (See Chapter 11 on page 47.) However, the instructor does not have to select from these choices.

Many boxes expect a number from 0 to 10, which indicates the resource’s capability to perform a particular skill, where 0 means “None” and 10 means “Outstanding”. This process is called Resource Factoring. See page 29.
4.3 Create/Edit Card For Resources

The *For Instructor* button allows the instructor to attach a comment to the card for the instructor’s eyes only. See Section 4.5 on page 29.

The Notes box can be spell-checked using a rudimentary spell-checker by pressing the *Spell Check* button. Avoid using the characters ~ and |, which SARDECK uses for internal purposes.

The button *Random* will randomly generate a resource using the method described in Appendix B on page 76. See Figure 4.5. A randomly generated card can be edited.

Right-clicking over the *Random* button, or over the *First* or *Last* textboxes in the *Name* group, brings up the menu shown in Figure 4.4. Selecting one of these inserts a random name *From Files Containing Fixed Names* described in Appendix B on page 76.

```
Create Female Name
Create Male Name
```

Fig. 4.4: Random Name

Pressing *Accept* saves the resource to disk, and the Firefighter card shows up on the main screen. See Figure 4.6.

Fig. 4.3: Create/Edit Resources-Firefighter
Fig. 4.5: Create/Edit Resources-Firefighter

Fig. 4.6: The Main Screen
Create/Edit Card For Resources-Law Enforcement

This allows the instructor to add or edit a Law Enforcement Resource card. See Figure 4.8.

There are various boxes to be completed. In many cases there are drop-down menu items to select from, which can be edited under the menu item Customize. (See Chapter 11 on page 47). However, the instructor does not have to select from these choices.

Many boxes expect a number from 0 to 10, which indicates the resource’s capability to perform a particular skill, where 0 means “None” and 10 means “Outstanding”. This process is called Resource Factoring. See page 29.

The For Instructor button allows the instructor to attach a comment to the card for the instructor’s eyes only. See Section 4.5 on page 29.

The Notes box can be spell-checked using a rudimentary spell-checker by pressing the Spell Check button. Avoid using the characters ~ and |, which SARDECK uses for internal purposes.

The button Random will randomly generate a resource using the method described in Appendix B on page 76. See Figure 4.9. A randomly generated card can be edited.

Right-clicking over the Random button, or over the First or Last textboxes in the Name group, brings up the menu shown in Figure 4.7. Selecting one of these inserts a random name From Files Containing Fixed Names described in Appendix B on page 76.

Fig. 4.7: Random Name

Pressing Accept saves the resource to disk, and the Law Enforcement card shows up on the main screen. See Figure 4.10.

Fig. 4.8: Create/Edit Resources-Law Enforcement
Chapter 4. Creating Cards

Fig. 4.9: Create/Edit Resources-Law Enforcement

Fig. 4.10: The Main Screen
Create/Edit Card For Resources-Ranger

This allows the instructor to add or edit a Ranger Resource card. See Figure 4.12.

There are various boxes to be completed. In many cases there are drop-down menu items to select from, which can be edited under the menu item Customize. (See Chapter 11 on page 47). However, the instructor does not have to select from these choices.

Many boxes expect a number from 0 to 10, which indicates the resource’s capability to perform a particular skill, where 0 means “None” and 10 means “Outstanding”. This process is called Resource Factoring. See page 29.

The For Instructor button allows the instructor to attach a comment to the card for the instructor’s eyes only. See Section 4.5 on page 29.

The Notes box can be spell-checked using a rudimentary spell-checker by pressing the Spell Check button. Avoid using the characters ~ and |, which SARDECK uses for internal purposes.

The button Random will randomly generate a resource using the method described in Appendix B on page 76. See Figure 4.13. A randomly generated card can be edited.

Right-clicking over the Random button, or over the First or Last textboxes in the Name group, brings up the menu shown in Figure 4.11. Selecting one of these inserts a random name From Files Containing Fixed Names described in Appendix B on page 76.

Fig. 4.11: Random Name

Pressing Accept saves the resource to disk, and the Ranger card shows up on the main screen. See Figure 4.14.

![Create/Edit Resources-Ranger](image-url)
Fig. 4.13: Create/Edit Resources-Ranger

Fig. 4.14: The Main Screen
Create/Edit Card For Resources-SAR Team

This allows the instructor to add or edit a Ranger SAR Team card. See Figure 4.15.

There are various boxes to be completed. In many cases there are drop-down menu items to select from, which can be edited under the menu item Customize. (See Chapter 11 on page 47). However, the instructor does not have to select from these choices.

Many boxes expect a number from 0 to 10, which indicates the resource’s capability to perform a particular skill, where 0 means “None” and 10 means “Outstanding”. This process is called Resource Factoring. See page 29.

The For Instructor button allows the instructor to attach a comment to the card for the instructor’s eyes only. See Section 4.5 on page 29.

The Notes box can be spell-checked using a rudimentary spell-checker by pressing the Spell Check button. Avoid using the characters ~ and |, which SARDECK uses for internal purposes.

The button Random will randomly generate a resource using the method described in Appendix B on page 76. See Figure 4.16. A randomly generated card can be edited.

Pressing Accept saves the resource to disk, and the SAR Team card shows up on the main screen. See Figure 4.17.

Fig. 4.15: Create/Edit Resources-SAR Team
Create/Edit Card For Resources-Town Person

This allows the instructor to add or edit a Town Person Resource card. See Figure 4.19.

There are various boxes to be completed. In many cases there are drop-down menu items to select from, which can be edited under the menu item Customize.
(See Chapter 11 on page 47). However, the instructor does not have to select from these choices.

Many boxes expect a number from 0 to 10, which indicates the resource’s capability to perform a particular skill, where 0 means “None” and 10 means “Outstanding”. This process is called Resource Factoring. See page 29.

The For Instructor button allows the instructor to attach a comment to the card for the instructor’s eyes only. See Section 4.5 on page 29.

The Notes box can be spell-checked using a rudimentary spell-checker by pressing the Spell Check button. Avoid using the characters ~ and |, which SARDECK uses for internal purposes.

The button Random will randomly generate a resource using the method described in Appendix B on page 76. See Figure 4.20. A randomly generated card can be edited.

Right-clicking over the Random button, or over the First or Last textboxes in the Name group, brings up the menu shown in Figure 4.18. Selecting one of these inserts a random name From Files Containing Fixed Names described in Appendix B on page 76.

Pressing Accept saves the resource to disk, and the Town Person card shows up on the main screen. See Figure 4.21.
Fig. 4.20: Create/Edit Resources-Town Person

Fig. 4.21: The Main Screen
4.4 Resource Factoring

Many resources with skills have a number from 0 to 10, which indicates the resource’s capability to perform a particular skill, where 0 means “None” and 10 means “Outstanding”. This process is called Resource Factoring. See Table 4.1.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>None</td>
</tr>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Well Below</td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Below</td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Above</td>
</tr>
<tr>
<td>7</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Well Above</td>
</tr>
<tr>
<td>9</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Outstanding, Nothing Better</td>
</tr>
</tbody>
</table>

4.5 For Instructor

*For Instructor* allows the instructor to attach a comment to the card for the instructor’s eyes only. See Figure 4.22.

A typical instructor’s comment attached to a clue card might be “This shoe belongs to the subject.”

These instructor’s comments are visible in only two places.

1. When the instructor edits the card to which the comment is attached.
2. When the instructor creates a Timeline (see Chapter 10 on page 44) and selects View, Print, or Save Playbook With Comments in the View Exercise window (see Chapter 9 on page 39).

The comment can be spell-checked using a rudimentary spell-checker. Avoid using the characters∼ and |, which SARDECK uses for internal purposes.
5. **Project A Card**

When the instructor selects *Project A Card*, *Project A Random Card*, or *Project The Scenario*, the related item is displayed in its own screen in large red type. See Figure 5.1, for example.

This could be used if the instructor wants to display the item to a large audience.

Right-clicking the mouse brings up the *Project A Card* Context Menu with the options shown in Figure 5.2.

- *Increase Font Size*, which increases the current font size by two points. Pressing the “CTRL I” keys generate the same effect.
- *Decrease Font Size*, which decreases the current font size by two points. Pressing the “CTRL D” keys generate the same effect.
- *Pick Font Color*, which allows the instructor to change the color of the font.
- *Help*, which brings up the help screen.
- *Close*, which closes the *Project A Card* screen.
Fig. 5.2: The *Project A Card* Context Menu
6. The *Scenario* Menu

6.1 Overview

There are three options under the *Scenario* menu. See Figure 6.1.

![Scenario Menu](image)

**Fig. 6.1: The *Scenario* Menu**

- *Create/Edit Scenario*, which is used either to create a new scenario or to edit an existing one. See Section 6.2 on page 32.
- *Print Scenario*, which prints the current scenario.
- *Project The Scenario*, which projects the current scenario. See Chapter 5 on page 30.

Each of these menu items is now treated in turn, as warranted.

6.2 Create/Edit Scenario

*Create/Edit Scenario* allows the instructor either to create a new scenario or to edit the existing one. The scenario file is named “Scenario.txt”, and is automatically saved or loaded from the same folder as the Deck. There can be only one scenario per Deck.

This is a rudimentary text editor. See Figure 6.2.
There are four main menu items.

- **File** with seven options. See Figure 6.3.
  
  - *Save*, which saves the current scenario as Scenario.txt in the same folder as the Deck. This is also available from the toolbar.
  
  - *Save And Close*, which saves the current scenario as Scenario.txt in the same folder as the Deck, and then closes the text editor.
  
  - *Print*, which prints the scenario. This is also available from the toolbar.
  
  - *Save As A TeX File*, which creates a TeX file from the scenario. See Appendix A on page 73. If the instructor has TeX installed, then the instructor can print the scenario in a professional manner by opening this TeX file.
  
  - *Scenario Skeleton*, which presents the instructor with a number of suggestions from which to create a fleshed-out scenario.
  
  - *Import Text*, which allows the instructor to import any text file.
  
  - *Close*, which closes the text editor.

- **Edit** with four options. See Figure 6.4.
Fig. 6.4: The Edit Menu

- *Copy*, which copies the highlighted text to the clipboard. This is also available from the toolbar.
- *Cut*, which deletes the highlighted text, and places it in the clipboard. This is also available from the toolbar.
- *Paste*, which copies the contents of the clipboard at the cursor position. This is also available from the toolbar.

The instructor could use the *Scenario Skeleton* as the basis for constructing a scenario. See Figure 6.6.

Fig. 6.6: The Scenario Skeleton

Or create a scenario in free-form. See Figure 6.7.

Fig. 6.5: The Tools Menu

- *Convert Case*, which allows the instructor to change the case of the highlighted text, using either *Lower Case, Upper Case, Invert Case*, or *Sentence Case*.
- *Spell Check*, which invokes a rudimentary spell checker. This is also available from the toolbar.

The instructor could use the *Scenario Skeleton* as the basis for constructing a scenario. See Figure 6.6.

Or create a scenario in free-form. See Figure 6.7.
Fig. 6.7: The Scenario In Free-Form
7. The *Images* Menu

7.1 Overview

There are two options under the *Images* menu. See Figure 7.1.

![Image Menu](image.png)

Fig. 7.1: The *Images* Menu

- *Import Images To Deck*, which copies the selected image to the same folder as “SARDECK.sar”, and can then be used as part of the Table-Top Exercise. (See Chapter 8 on page 38.)

Examples of images that might be imported are
- A recent photograph of the subject.
- A photograph of an article of clothing the subject is believed to be wearing.
- A photograph of a shoe print on a trail.
- A copy of the trail log that the subject signed.
7.2 Image Viewer

When the instructor selects *Open Image Viewer* under the *Images* menu, the screen shown in Figure 7.2 appears.

There are three main menu items.

- **File**, which exposes the menu items shown in Figure 7.3.
  - *Open Image*, which allow the instructor to open an image file. The file could be JPEG (.jpg), GIF (.gif), Bitmap (.bmp), or TIFF (.tif) files.
  - *Import Image*, which copies the opened image to the same folder as “SARDECK.sar”, and can then be used as part of the Table-Top Exercise. (See Chapter 8 on page 38.)
  - *Save Image*, which saves the opened image, usually after it has been manipulated.
  - *Print Image*, which prints the opened image.
  - *Close*, which closes the Image Viewer.

- **View**, which exposes menu items which allows the instructor to view the image Fullsize, Zoom In on the image, Zoom Out, or Restore the original image.

- **Manipulate Image**, which exposes menu items which allows the instructor to convert the image to Gray Scale, Invert the image’s colors (sometimes called a negative), Undo/Redo the previous two commands, Rotate the image 90° to the left, Rotate the image 90° to the right, Flip the image horizontally, or Flip the image vertically. None of these operations is permanent. The original image on disk is unchanged, unless the instructor chooses *Save Image*.
8. The *Table-Top Exercise* Menu

There are six options under the *Table-Top Exercise* menu. See Figure 8.1.

- **Start New Exercise**, which is used to start a new Table-Top Exercise. The instructor is asked to supply a name for the exercise, which also becomes the name of the file (with extension “tte”). See Figure 8.2. The exercise file is saved in the same folder as the Deck. The instructor can create different Table-Top Exercises with the same Deck, all using the same scenario.

- **View Current Exercise**, which allows the instructor to view and manipulate the current exercise. See Chapter 9 on page 39.
- **Rename Current Exercise**, which allows the instructor to rename the current exercise.
- **Open Existing Exercise**, which allows the instructor to select the Table-Top Exercise to work with. It has the extension “tte”.
- **Timeline**, which allows the instructor to create a timeline that describes the subject’s movements based on an appropriate map. See Chapter 10 on page 44.
- **Add Checked Cards To Exercise**, which adds those cards selected using the *Elements* Context Menu. See Chapter 3 on page 12. For more details see Chapter 13 on page 53, *How To Add Cards To Exercise*. 

![Fig. 8.1: The Table-Top Exercise Menu](image1)

![Fig. 8.2: Start New Exercise](image2)
9. The View Exercise Menu

View Exercise is where the instructor can view and manipulate the current Table-Top Exercise. If the instructor selects Start A New Exercise (see Chapter 8 on page 38), and then immediately views it, the instructor will see Figure 9.1.

There is only one item on the list so far, namely the scenario. More items are to be added. There are four buttons on the right-hand side, as yet unavailable, and three menu items across the top.

1. File, which exposes three menu items seen in Figure 9.2.
Chapter 9. The View Exercise Menu

Fig. 9.2: The View Exercise Menu

a) View Condensed Exercise, which displays the current exercise in condensed form, where the different fields are separated by commas, and carriage returns in Comments are replaced by the symbol |.

b) Print Condensed Exercise, which prints the current exercise in condensed form, where the different fields are separated by commas, and carriage returns in Comments are replaced by the symbol |.

c) Close, which closes the view of this exercise.

2. Cards, which exposes two menu items seen in Figure 9.3.

Fig. 9.3: The Cards Menu

a) Add Comment To End Of Exercise, which allows the instructor to add a comment using a rudimentary text editor with essentially the same features as the Scenario Editor (see Chapter 6 on page 32) shown in Figure 9.4.

Fig. 9.4: Add Comment To End Of Exercise

The comment is then placed at the end of the exercise list as its own item. See Figure 9.5.
Notice that two of the buttons on the right are now available, both with up arrows. These four buttons allow the instructor to reorder the items in the list. The button with the single up arrow, moves the highlighted item up one spot. The double arrow button moves the item to the top of the list. The down arrow buttons work in a similar way, when it makes sense. The same result is obtained by using the Context Menu.

b) Add Image’s Filename To End Of Exercise, which allows the instructor to add an imported image’s filename to the Table-Top Exercise.
By moving the cursor in the left-hand panel of Figure 9.6, the corresponding image is displayed in the right-hand panel. Clicking *Accept* adds the selected image’s filename to the end of the exercise list as its own item.

3. *Playbook*, which exposes 11 items shown in Figure 9.7.

![Fig. 9.7: The Playbook Menu](image)

The menu items containing the term “With Comments” are designed for the instructor. Those which contain the term “Without Comments” are meant for the participants. All cards are numbered sequentially, with the Scenario being thought of as Card #1. All comments are preceded by the word “Instructor” and numbered sequentially.

a) *View Playbook With Comments*, which shows the entire exercise, with all the elements displayed in an easily readable format. All comments, both those added here and those previously attached to cards using *For Instructor* (see Section 4.5 on page 29), are shown.

b) *Print Playbook With Comments*, which prints the entire exercise, with all the elements displayed in an easily readable format. All comments, both those added here and those previously attached to cards using *For Instructor* (see Section 4.5 on page 29), are printed.

c) *Save Playbook To Text File With Comments*, which saves the entire exercise, as a “.txt” file. All comments, both those added here and those previously attached to cards using *For Instructor* (see Section 4.5 on page 29), are saved.

d) *Save Playbook To TeX File With Comments*, which saves the entire exercise as a TeX file. See Chapter A on page 73. All comments, both those added here and those previously attached to cards using *For Instructor* (see Section 4.5 on page 29), are shown.

e) *View Playbook Without Comments*, which shows the entire exercise, with all the elements displayed in an easily readable format. All comments, both those added here and those previously attached to cards using *For Instructor* (see Section 4.5 on page 29), are hidden.
Chapter 9. The View Exercise Menu

f) *Print Playbook Without Comments*, which prints the entire exercise, with all the elements displayed in an easily readable format. All comments, both those added here and those previously attached to cards using For Instructor (see Section 4.5 on page 29), are hidden.

g) *Save Playbook To Text File Without Comments*, which saves the entire exercise, with all the elements displayed in an easily readable format, as a "txt" file. All comments, both those added here and those previously attached to cards using For Instructor (see Section 4.5 on page 29), are hidden.

h) *Save Playbook To TeX File Without Comments*, which saves the entire exercise as a TeX file. See Chapter A on page 73. All comments, both those added here and those previously attached to cards using For Instructor (see Section 4.5 on page 29), are hidden.

i) *Print Timeline*, which prints the current Timeline.

j) *Print Images*, which prints the images used in the Exercise.

k) *Save Cards To TeX File*, which creates a TeX file from the collection of cards in the exercise. See Chapter A on page 73. If the instructor has TeX and the Flashcards\(^1\) macro installed, then the instructor can print all the cards in a professional manner by opening this TeX file.

If the instructor right-clicks over an item in the list, then the View Exercise Context Menu is exposed. See Figure 9.8

<table>
<thead>
<tr>
<th>Remove Card From Exercise</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Comment</td>
</tr>
<tr>
<td>Add Comment Before This Entry</td>
</tr>
<tr>
<td>Add Image's Filename Before This Entry</td>
</tr>
<tr>
<td>Move To Top</td>
</tr>
<tr>
<td>Move Up</td>
</tr>
<tr>
<td>Move Down</td>
</tr>
<tr>
<td>Move To Bottom</td>
</tr>
<tr>
<td>Help</td>
</tr>
</tbody>
</table>

Fig. 9.8: The View Exercise Context Menu

The following items are available.

1. *Remove Card From Exercise*, which removes the highlighted card or comment from the exercise, but it does not remove it from the original Deck. The scenario can never be removed from the exercise.

2. *Edit Comment*, which allows the instructor to edit the highlighted comment.

3. *Add Comment Before This Entry*, which allows the instructor to add a comment using a rudimentary text editor with essentially the same features as the Scenario Editor (see Chapter 6 on page 32) shown in Figure 9.4. The comment is then placed before the current entry in the exercise list as its own item.

4. *Add Image’s Filename Before This Entry*, which allows the instructor to add an imported image’s filename. See Figure 9.6. The image’s filename is then placed before the current entry in the exercise list as its own item.

5. *Move To Top*, which moves the highlighted item to the top of the list.

6. *Move Up*, which moves the highlighted item up one spot.

7. *Move Down*, which moves the highlighted item down one spot.

8. *Move To Bottom*, which moves the highlighted item to the bottom of the list.

9. *Help*, which brings up the SARDECK help page.

Double clicking on any line, brings up a window with the contents of that line displayed in full.

In order to add other Cards to the exercise, see How To Add Cards To Exercise on page 53.

This window and the main window can be open simultaneously.

\(^1\) http://www.ctan.org/tex-archive/macros/latex/contrib/flashcards/.
10. The *Timeline* Menu

*Timeline* allows the instructor to create a timeline that describes the subject’s movements based on an appropriate map.

When the instructor selects *Timeline* from the *Table-Top Exercise* menu, see Chapter 8 on page 38, the window shown in Figure 10.1 opens.

![Timeline](image)

Fig. 10.1: Timeline

There are two main menu items, *Timeline* and *Help*.

1. *Timeline*, which exposes the nine menu items shown in Figure 10.2.
a) *Add An Entry*, which allows the instructor to add entries to the timeline by completing the window shown in Figure 10.3.

This is where the instructor indicates where the subject is at a particular time and any event or clue associated with that location. Events are saved automatically.

Figure 10.4 is what the timeline might look like after a number of events have been added.
With an event highlighted, the *Timeline* Context Menu shown in Figure 10.5 is exposed.

![Timeline Context Menu](image)

Fig. 10.5: The *Timeline* Context Menu

i. *Delete Entry*, which deletes the entry.

ii. *Edit Entry*, which allows the instructor to edit the entry.

b) *Sort Timeline*, which sorts the timeline entries in chronological order. It is irreversible.

c) *Print Timeline*, which prints the timeline.

d) *Save Timeline To Text File*, which prints the timeline to a text file.

e) *Save Timeline To TeX File*, which creates a TeX file from the timeline. If the instructor has TeX installed, the timeline can be printed in a professional manner by opening this TeX file. See Appendix A on page 73.

f) *Increase Font Size*, which increases the current font size by two points. Pressing the “CTRL I” keys generate the same effect. This facility might be useful at the end of a Table-Top Exercise (see Chapter 8 on page 38) if the Timeline is being projected during debriefing.

g) *Decrease Font Size*, which decreases the current font size by two points. Pressing the “CTRL D” keys generate the same effect.

h) *Pick Font Color*, which allows the instructor to change the color of the font.

i) *Close*, which closes the timeline.

2. *Help*, which brings up the SARDECK help.
11. The *Customize* Menu

This menu item is unavailable if the Application Folder cannot be written to.

Selecting the *Customize* menu displays the submenu shown in Figure 11.1.

![Customize Menu](image1)

**Fig. 11.1: The *Customize* Menu**

This menu allows the instructor to change some of the drop-down options that are used when creating certain resource cards described in Chapter 4 on page 16.

The *Customize* menu contains the following items:

- *Firefighter*, which exposes the submenu items shown in Figure 11.2.

![Firefighter Submenu](image2)

**Fig. 11.2: The *Firefighter* Submenu**

Clicking on *Rank* brings up a window similar to the one shown in Figure 11.3, which shows all the existing Firefighter Ranks.

![Firefighter Ranks](image3)

**Fig. 11.3: The *Firefighter Ranks***

The selected item from the list of Ranks is automatically placed into the *Entry To Edit* and *Entry To Delete* boxes. The instructor can then edit the entry and click on *Accept Edit*. The instructor can delete the entry by clicking on *Delete Entry*.

To add an entry, enter it into the *Entry To Add* and click on *Add Entry*.

When finished editing this list, clicking on *Save* saves it permanently.

Clicking on any other entry in Figure 11.2 displays a window similar to Figure 11.3.
• Law Enforcement, which exposes the submenu items shown in Figure 11.4.

![Fig. 11.4: The Law Enforcement Submenu](image)

Clicking on any of these entries displays a window similar to Figure 11.3.

• Ranger, which exposes the submenu items shown in Figure 11.5.

![Fig. 11.5: The Ranger Submenu](image)

Clicking on any of these entries displays a window similar to Figure 11.3.

• SAR Team, which exposes the submenu items shown in Figure 11.6.

![Fig. 11.6: The SAR Team Submenu](image)

Clicking on any of these entries displays a window similar to Figure 11.3.

• Town Person, which exposes the submenu items shown in Figure 11.7.

![Fig. 11.7: The Town Person Submenu](image)

Clicking on any of these entries displays a window similar to Figure 11.3.
12. The Help Menu

Selecting the Help menu displays the submenu shown in Figure 12.1.

- **Help Topics** opens the SARDECK Help file.
- **Manual** opens the SARDECK manual.
- **Check For Updates** goes to the Win C.A.S.I.E. III website, http://wcasie.com, (if connected to the web) and gets the latest SARDECK version number. If different from the current version, it offers to download the latest version. Close the current version of SARDECK before installing the latest version.
- **Credits** lists the people who have helped with the development of SARDECK. Their names can be found in the Preface on page v.
- **About** gives the copyright, authorship, version number, and release date information of SARDECK.

The Help menu contains the following items.

Fig. 12.1: The Help Menu
Part II

Using SARDECK
13. How To Add Cards To Exercise

This assumes that the instructor has created some Clues, Events, and Resources (see Chapter 4 on page 16), and created a Table-Top Exercise (see Chapter 8 on page 38). Here we demonstrate how to add Clues to the Exercise.

1. Highlight Clue in the Elements panel. See Figure 13.1.

![Fig. 13.1: Highlight Clue in the Elements Panel](image)

2. Right-click to bring up the Elements Context Menu. See Figure 13.2.
3. Click on *Select Cards For Exercise From Elements*, and the instructor will see the message shown in Figure 13.3.

![Figure 13.3: Instructions](image)

After the instructor clicks OK, unchecked boxes appear alongside each clue. See Figure 13.4. (Had the instructor clicked on *Select All Cards For Exercise From Elements*, the boxes are checked.)
4. Check the boxes alongside the Clues that the instructor wants to add to the Exercise. We have checked two boxes. See Figure 13.5.)
5. Open the *Table-Top Exercise* menu item, see Figure 13.6,

and select *Add Checked Cards To Exercise*.

6. The instructor will receive confirmation that cards have been added to the exercise. See Figure 13.7.
Chapter 13. How To Add Cards To Exercise

If the instructor selects *View Current Exercise* from the *Table-Top Exercise* menu (see Figure 13.6) the instructor can see the added Clues in Figure 13.8.

These items can be manipulated in *View Current Exercise*. See Chapter 9 on page 39.

Note: Cards added to a Table-Top Exercise are copies of the original cards. Editing the original cards at this stage will not affect the cards in the Table-Top Exercise.
14. How To Use SARDECK

1. Open SARDECK and, under the menu item File, (see Chapter 3 on page 9) select Start New Deck (see Section 3.2 on page 10).
2. Create a scenario by selecting Edit Scenario (Section 6.2 on page 32) under the menu item Scenario (see Chapter 6 on page 32).
3. Create a deck of cards for Clues, Events, and Resources, either by double clicking the appropriate Element in the Element panel, or by using the Element panel’s context menu. See Chapter 4 on page 16.
4. Create a Table-Top Exercise by selecting Start New Exercise under the Table-Top Exercise menu (see Chapter 8 on page 38).
5. Create a Timeline (see Chapter 10 on page 44) by selecting Timeline under the Table-Top Exercise menu (see Chapter 8 on page 38).
6. Add Cards to the Table-Top Exercise. See Chapter 13 on page 53. Note: Cards added to a Table-Top Exercise are copies of the original cards. Editing the original cards at this stage will not affect the cards in the Table-Top Exercise.
7. Add Comments to the Table-Top Exercise. See Chapter 9 on page 39.
8. Add Images’s Filename to the Table-Top Exercise. See Chapter 9 on page 39.
11. Read How To Run A Table-Top Exercise. See Chapter 16 on page 68.
15. An Example Of A Table-Top Exercise

A Table-Top Exercise comprises six components.

1. A Scenario, which summarizes the initial events on which the Exercise is based.
2. A Deck of electronic Cards, which describe possible Clues, Events and Resources that might be found during the exercise.
3. Images, which are associated with the scenario or cards.
4. A Timeline, which describes in time, such items as the subject’s movements, the weather, the start of the search, when clues were left, etc.
5. A Playbook, which is an ordered list of instructions containing such items as the cards, comments, image filenames, reminders, and advice for running the exercise.
6. An associated map with the pertinent locations identified. The instructor supplies this.

In this chapter we give examples of each of these, except the map.

15.1 An Example Of A Scenario

Created by SARDECK, Version 0.08 on 9/22/2008
Deck Name: Grandpa Lewis
Deck Location: C:\SARDECK\Grandpa Lewis

SCENARIO
Name: Harold Paul Lewis
Age: 88
Location Last Seen: Home
Address at Location Last Seen: 3556 Lake Road
Weight: 140 lbs
Height: 5'1"
Hair Color: Grey
Hair Length: thin, stringy and long.
Clothing worn at time last seen: Unknown
Events prior to disappearance: Gone in A.M. when his daughter got up.
Medical issues: Alzheimer’s, arthritis, stroke in 2003
Shoe size: 10
Footwear: Possibly Brown Slippers
Name of reporting person: Eleanor Dubay
Relationship to missing: Daughter
Has a hasty search been performed? Yes
What has been searched? House, yard, car
Has the PLS been searched? Yes

Mr. Lewis lives in a rural area with his daughter Eleanor who is a widow. Mr. Lewis is suffering from an advanced state of Alzheimer’s disease. Recently Mr. Lewis has been more confused than usual. He thinks his parents and sister are still alive and living in the old farmhouse down the road where he grew up.

Mr. Lewis is a good swimmer and underwent water therapy for his arthritis. When younger he was a hunter and angler with some pretty good stories to go with his pastimes.

The daughter states that her Dad is always up at 0700 hrs and takes his medications. Yesterday he went to the doctor and his medication was changed. Last night before bed Mr. Lewis was confused and very agitated. She had planned to call the doctor this morning to discuss this but when she went to see why her father had not come out for his breakfast it appeared too late.

Neighbors are few and far between. There is a small lake several miles down the road. It is late summer and the nights are getting cool.

It is now 0830 hours and a formal search is about to begin as you, the Incident Command Staff and General staff, begin the search for Harold Lewis.

You must develop an Incident Action Plan. The IAP must answer the following four questions. Be prepared to go over the IAP in 15 minutes.

1. What do we want to do? (Incident Objectives)
2. Who is responsible for doing it? (Organizational Chart)
3. How do we communicate with each other? (Communications Plan)
4. What is the procedure if someone is injured? (Safety Plan)

Resources arrive at the Command Post. This is the start of OP #1.

Run CASIE, and start an Initial Note.

15.2 An Example Of Cards

Figures A.1 and A.2 on pages 74 and 75 are scaled-down samples that then are separated using a guillotine to generate the individual cards.
15.3 An Example Of An Image

C:\SARDECK\Grandpa Lewis\Grandpa Lewis.jpg
15.4 An Example Of A Timeline

Timeline for Table-Top Exercise: Warm Up

<table>
<thead>
<tr>
<th>Day</th>
<th>Time</th>
<th>Location</th>
<th>Event/Clue</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>04:45</td>
<td>Home</td>
<td>Mr. Lewis leaves house</td>
</tr>
<tr>
<td>1</td>
<td>05:00</td>
<td>Point A on map</td>
<td>Temperature 45</td>
</tr>
<tr>
<td>1</td>
<td>05:00</td>
<td>Point A on map</td>
<td>Mr. Lewis seen by Mrs Peters</td>
</tr>
<tr>
<td>1</td>
<td>06:15</td>
<td>Point B on map</td>
<td>Mr. Lewis reaches previous home</td>
</tr>
<tr>
<td>1</td>
<td>07:00</td>
<td>Point B on map</td>
<td>Mr. Lewis falls asleep</td>
</tr>
<tr>
<td>1</td>
<td>08:30</td>
<td>Command Post</td>
<td>Search starts</td>
</tr>
<tr>
<td>1</td>
<td>09:30</td>
<td>Phone call</td>
<td>Mrs. Peters calls with clue</td>
</tr>
<tr>
<td>1</td>
<td>11:00</td>
<td>Point B on map</td>
<td>Mr. Lewis wakes up</td>
</tr>
<tr>
<td>1</td>
<td>11:30</td>
<td>Point B on map</td>
<td>Mr. Lewis heads for lake</td>
</tr>
<tr>
<td>1</td>
<td>11:40</td>
<td>Point C on map</td>
<td>Temperature 50. Heavily overcast.</td>
</tr>
<tr>
<td>1</td>
<td>11:45</td>
<td>Point C on map</td>
<td>Mr. Lewis loses slipper</td>
</tr>
<tr>
<td>1</td>
<td>11:50</td>
<td>Point D on map</td>
<td>Starts to drizzle</td>
</tr>
<tr>
<td>1</td>
<td>12:00</td>
<td>Point D on map</td>
<td>Mr. Lewis collapses in ditch</td>
</tr>
<tr>
<td>1</td>
<td>23:00</td>
<td>Point D on map</td>
<td>Starts to rain heavily. Overnight low 35.</td>
</tr>
<tr>
<td>2</td>
<td>05:00</td>
<td>Point D on map</td>
<td>Stops raining</td>
</tr>
<tr>
<td>2</td>
<td>07:00</td>
<td>Point D on map</td>
<td>Mr. Lewis expires</td>
</tr>
<tr>
<td>2</td>
<td>08:00</td>
<td>Point D on map</td>
<td>Bright sunny day</td>
</tr>
</tbody>
</table>

15.5 An Example Of A Playbook

Exercise: WARM UP

Instructor 1

COMMENT

This scenario needs some preplanning. The PLS should be in a rural area about 1 to 1.5 miles from his home. Choose a house near or on the lake for the home of Mr. Lewis when he was growing up.

This scenario is straight forward and solved using what we know about Alzheimer’s behavior.
Everything should be dealt with using the Incident Command System. For example: Injuries by searchers should be covered under the medical plan and management should have little or no involvement.

The use of a preplan, Incident Action Plan and Demobilization Plan should all be required.

This exercise is meant for a warm-up and introduction to how SARDECK can be a valuable training tool for SAR Management and Planning.

1
SCENARIO
Name: Harold Paul Lewis
Age: 88
Location Last Seen: Home
Address at Location Last Seen: 3556 Lake Road
Weight: 140 lbs
Height: 5’1’’
Hair Color: Grey
Hair Length: thin, stringy and long.
Clothing worn at time last seen: Unknown
Events prior to disappearance: Gone in A.M. when his daughter got up.
Medical issues: Alzheimer’s, arthritis, stroke in 2003
Shoe size: 10
Footwear: Possibly Brown Slippers
Name of reporting person: Eleanor Dubay
Relationship to missing: Daughter
Has a hasty search been performed? Yes
What has been searched? House, yard, car
Has the PLS been searched? Yes

Mr. Lewis lives in a rural area with his daughter Eleanor who is a widow. Mr. Lewis is suffering from an advanced state of Alzheimer’s disease. Recently Mr. Lewis has been more confused then usual. He thinks his parents and sister are still alive and living in the old farmhouse down the road where he grew up.

Mr. Lewis is a good swimmer and underwent water therapy for his arthritis. When younger he was a hunter and angler with some pretty good stories to go with his pastimes.

The daughter states that her Dad is always up at 0700 hrs and takes his medications. Yesterday he went to the doctor and his medication was changed. Last night before bed Mr. Lewis was confused and very agitated. She had planned to call the doctor this morning to discuss this but when she went to see why her father had not come out for his breakfast it appeared too late.

Neighbors are few and far between. There is a small lake several miles down the road. It is late summer and the nights are getting cool.
It is now 0830 hours and a formal search is about to begin as you, the Incident Command Staff and General staff, begin the search for Harold Lewis.

You must develop an Incident Action Plan. The IAP must answer the following four questions. Be prepared to go over the IAP in 15 minutes.

1. What do we want to do? (Incident Objectives)
2. Who is responsible for doing it? (Organizational Chart)
3. How do we communicate with each other? (Communications Plan)
4. What is the procedure if someone is injured? (Safety Plan)

Resources arrive at the Command Post. This is the start of OP #1.

Run CASIE, and start an Initial Note.

Instructor 2
COMMENT
The following resources are available. Remind participants to enter into CASIE’s Initial Note.

2
Resources-Law Enforcement
Trooper Hannibal Lenka
Organization: State Police
Primary Skill: K-9 Trailing
SAR Skills: 5 Investigation: 5
SAR Experience: 6 Leadership: 4
Abduction Tactics: 5 Clue Detection: 6
Abduction Training: 4 ICS Section: Operations
Equipment: Bloodhound
Note:

3
Resources-Law Enforcement
Trooper Geraldo Broz
Organization: State Police
Primary Skill: Wilderness SAR
SAR Skills: 6 Investigation: 5
SAR Experience: 5 Leadership: 3
Abduction Tactics: 4 Clue Detection: 5
Abduction Training: 0 ICS Section: Operations
Equipment:
Note:

4
Resources-Ranger
Forestry Technician Mack Blanchard
Affiliation: Forest Service
Primary Skill: Ground Searcher K-9 Water: 0
Rescue: 4 Training: 5
Ground Searcher: 8 Experience: 6
Equipment On Site: Leadership: 6
Equipment Operability: 5 Clue Detection: 6
K-9 Airscent: 0 Extraction: 4
K-9 Trailing: 0 ICS Section: Operations
K-9 Cadaver: 0
Note: Very mature and knowledgeable.

5
Resources-SAR Team
Team Name: Settler SAR Volunteers
Type: Ground Search
Number In Team: 6
Skill Level: 7
Note: Experienced and reliable team.

Instructor 3
COMMENT
If the Liaison person requests a photo of Mr. Lewis, supply his image.

Instructor 4
IMAGE FILENAME
MrLewis.jpg

Instructor 5
COMMENT
If the Liaison person asks about his childhood home, give this Event-Investigation.

6
EVENT-INVESTIGATION
Old Home Address is 540 Shoreline Rd., Settler.

Assign an appropriate task.

*** Instructor’s Comment: This is one of your two locations that Mr. Lewis can be found with the deck in this scenario. ***

Instructor 6
COMMENT
If the searchers have notified the locals that Mr. Lewis is missing, then give the Peters’ Clue Card.
CLUE
Mrs. Peters states to the Police dispatcher that she saw Mr. Lewis headed toward the lake this morning at 0500 hrs.

Determine the influence of this clue for search planning.

*** Instructor’s Comment: Mrs. Peters is listed as a resource and if checked will find that she is very reliable. Don’t forget to give that Resource card when you give the clue. ***

Instructor 7
COMMENT
If the Liaison person asks for information on Mrs Peters, supply the Resources-Town Person card.

Resources-Town Person
Mrs. Verna Peters
Affiliation: Citizen
Area of Expertise: Community Affairs
SAR Training: 3 Good Sense: 5
SAR Experience: 3 Reliability: 7
SAR Equipment: 2 Age: 53
SAR Section: Logistics Health: 5
Leadership: 5 Years of Residence: 53
Organized: 6 Employed: No
Credibility: 6 Employer:
Note: Very active in town. Everybody knows Verna. She serves as a School Board member and is trusted by all.

EVENT-WEATHER
Rain headed our way!

What changes need to be made and how will these changes be addressed.

*** Instructor’s Comment: The rain presents addition concerns and ups the search urgency. Searcher safety is management’s #1 responsibility. ***

Instructor 8
COMMENT
If before 11:30, use this Event-Find.

EVENT-FIND
Mr. Lewis has been found. He was sitting on the back porch of the house where he grew up.
Bring him home and demobilize.

Instructor 9
COMMENT
If after 11:45, use this Clue.

11
CLUE
A brown slipper size 10 has been found by the bloodhound.

The instructor will point out where this clue was located.

*** Instructor’s Comment: This belongs to Mr. Lewis. ***

Instructor 10
COMMENT
If after 12:00 on Day 1, use this Event-Find.

12
EVENT-FIND
Mr. Lewis is found lying in a ditch, alive but unable to get up, and shaken up.

Follow preplan and demobilization plan. Next discuss learning points with the instructor.

*** Instructor’s Comment: Demobilization plan should have been completed by the Plans Section. ***
16. How To Run A Table-Top Exercise

These are suggestions on How To Run A Table-Top Exercise assuming that the exercise is an all day affair.

Objectives

1. To give participants experience in running various types of searches, including creating IAPs and using ICS.
2. To give participants experience in using Win C.A.S.I.E. III.
3. To give participants the opportunity to integrate Win C.A.S.I.E. III into various types of searches.

Components

A Table-Top Exercise consists of the following components.

1. Participants divided into teams of 4.
2. An Instructor and his/her Aids. Approximately one Aid per team. If the participants are unfamiliar with the search area, the Aids are expected to have local knowledge as to the past history of searches and act as consultants.
3. SARDECK generated exercise.

Overview

The Instructor and Aids create three scenarios.

1. Scenario 1 is a straight-forward hasty search, perhaps looking for an Alzheimer’s patient. Expected to last 1 hour.
2. Scenario 2 is a straight-forward large-scale search, perhaps looking for a multi-day overdue hiker. Expected to last 4 hours or more.
3. Scenario 3, which could be Scenario 2 with a different ending, is a search in which distracting external events play a role. Used when a team finishes Scenario 2.

No bastard searches, although in Scenario 3 this could be suggested as a possibility.

Must prepare enough decks for each team and for each scenario.

Each Scenario is preceded by a slide show of the search area.

Prerequisites Of Participants

1. Knowledge of POA, POD, ROW, and CPOD.
2. Know how to run Win C.A.S.I.E. III.
3. One laptop per team, with the latest version of Win C.A.S.I.E. III running.
4. If possible, bring a printer, one per team.
5. Pre-registration (so there are enough decks, maps, etc).

Instructions

1. Participants divided into teams of 4.
3. The liaison person is the individual who interacts with the Instructor/Aid. He/she collects any questions, requests resources, requests interviews, etc.
He is the middle-man. (He may have other jobs as well.)

**Procedures**

1. OP is 12 hours.
2. 10–15 minutes real time is 1 hour search time. (OP is 2–3 hours real time)
3. Team is given scenario.
   a) Decide what they want to do in next OP.
   b) Requests resources/interview through liaison person.
   c) Instructor/Aid gives available resources.
   d) Team allocates resources.
   e) End of OP Instructor/Aid tells result of allocation. Gives clue cards. Might do this before end of OP.
   f) Team decide what they want to do, and repeat the process.
4. Aids move around, making sure teams have no trouble running Win C.A.S.I.E. III.
5. When the exercise is over, the subject is “de-briefed” by projecting the Timeline.

**Physical Setup**

1. A table and chairs for each team equipped with
   a) A computer (supplied by team)
   b) Map and wax markers
   c) IAP, ICS Forms. Ability to print out other forms, if needed.
2. A private area and table for the Instructor and Aids equipped with
   a) Computer running SARDECK.
   b) Printer, card paper, and guillotine, in the event we need to print more cards.
   c) A deck of cards for each team, separated, and controlled by the appropriate Aid.
   d) The Table-Top Exercise with comments printed for each aid, who can check off what has been given to the teams.
   e) Each Aid’s team has a folder with all current information. Thus, if a real search comes down, and an Aid has to leave, another Aid can take over and will know exactly where the team is.
3. Projection capabilities for the room.
A. \TeX

\TeX{} is a document preparation system for high-quality typesetting developed by Donald Knuth.\footnote{\url{http://en.wikipedia.org/wiki/TeX}.} It comes in many flavors, most of which are free. MiK\TeX{} is a popular one.\footnote{\url{http://miktex.org/}.}

To print the cards the instructor will also need the \verb|Flashcards| macro installed together with the configuration file “\verb|myconfig1.cfg|”, which can be found in the same folder as \verb|SARDECK.exe|. Figures A.1 and A.2 are scaled-down samples that then are separated using a guillotine to generate the individual cards.

However, learning \TeX{}, while worthwhile, is non-trivial, so it may be better to find a colleague who is already experienced with \TeX{} rather than learning it just for SARDECK.

If the instructor has trouble finding someone to generate a PDF document from any of the \TeX{} document produced by SARDECK, then zip the entire contents of the folder containing “\verb|SARDECK.sar|”, and email it to David Lovelock at dsl@math.arizona.edu. He will return the PDF document in a timely manner at no charge. However, by doing this the instructor agrees to let the corresponding deck be available to all users of SARDECK at no charge.

This manual was produced using \TeX{}.

\footnote{\url{http://www.ctan.org/tex-archive/macros/latex/contrib/flashcards/}.}
<table>
<thead>
<tr>
<th>CLUE</th>
<th>CLUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>A baseball cap with the subject’s name written on the inside has been located. The class instructor will point out on the map where the clue was discovered. Enter this clue in CASIE and a clue log. Once the clue is further investigated, and if it has no bearing on the search, it may be removed from CASIE.</td>
<td>A call has come in that a citizen heard a child crying in back of their home about 2 hours ago. They searched the area and didn’t find the source. The class instructor will point out on the map the reported location of the clue. Enter this clue in CASIE and a clue log. Once the clue is further investigated, and if it has no bearing on the search, it may be removed from CASIE.</td>
</tr>
<tr>
<td>A call to the Command Post from a man stating that he saw the subject an hour ago at the restaurant in town. The class instructor will point out on the map the reported location of the clue. Enter this clue in CASIE and a clue log. Once the clue is further investigated, and if it has no bearing on the search, it may be removed from CASIE.</td>
<td>A call to the Command Post from a woman stating that she saw the subject an hour ago at the Park Gift Shoppe. The class instructor will point out on the map the reported location of the clue. Enter this clue in CASIE and a clue log. Once the clue is further investigated, and if it has no bearing on the search, it may be removed from CASIE.</td>
</tr>
</tbody>
</table>

Fig. A.1: Clue Cards
<table>
<thead>
<tr>
<th>Name</th>
<th>Organization</th>
<th>Primary Skill</th>
<th>SAR Skills</th>
<th>SAR Experience</th>
<th>Abduction Tactics</th>
<th>Abduction Training</th>
<th>Investigation</th>
<th>Leadership</th>
<th>Clue Detection</th>
<th>Equipment</th>
<th>ICS Section</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sheriff Wendell McLaws</td>
<td>County Police</td>
<td>Mapping Technician</td>
<td>5</td>
<td>0</td>
<td>10</td>
<td>1</td>
<td>6</td>
<td>4</td>
<td>1</td>
<td></td>
<td>Planning</td>
<td></td>
</tr>
<tr>
<td>Chief Deputy Mandi Mood</td>
<td>Highway Patrol</td>
<td>Underwater Recovery</td>
<td>1</td>
<td>2</td>
<td>8</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>3</td>
<td></td>
<td>Incident Commander</td>
<td></td>
</tr>
<tr>
<td>Private Mervin Ogilvie</td>
<td>Sheriff’s Department</td>
<td>C.A.S.I.E. Operator</td>
<td>0</td>
<td>4</td>
<td>2</td>
<td>6</td>
<td>3</td>
<td>8</td>
<td>5</td>
<td></td>
<td>Logistics</td>
<td></td>
</tr>
</tbody>
</table>
This is an explanation of the way that SARDECK generates a Resource when the Random button is clicked (see Chapter 4 on page 16). This occurs when creating

- Firefighters. See page 18.
- Law Enforcement personnel. See page 21.
- Rangers. See page 23.
- SAR Teams. See page 25.

In all cases the First and Last names are randomly selected in one of the following two ways, determined randomly.

1. **From Files Containing Fixed Names.** These names are selected from over 500 people in history, literature, science, art, fiction, theater, films, etc. Some names have been changed in not so subtle ways. Some examples: Hermione Granger, Jane Eyre, Florence Nightingale, Amelia Earhart, Angie Jolly, Demi Enough, Jackie Ennedy, Hugh Lorry, Will Clintern, Luke Skywalker, Indiana Jones, James Blond, Bud Weiser, Clark Kent, Rooster Cogburn, Atticus Finch, Daniel Boone.

   An electronic coin is flipped. If it shows heads, then a female name is selected. If tails, then a male name is selected.

2. **From The US Consensus.** An electronic coin is flipped. If it shows heads, then the resource is female and a first name is selected from one of the 4,275 female first names in the 2000 US census. If the coin shows tails, then the resource is male and a first name is selected from one of the 1,219 male first names in the 2000 US census. Then a last name is selected from one of the 88,799 last names in the 2000 US census.

   The contents of the boxes that have non-numeric drop-down menu items are randomly selected from these items.

   The contents of the boxes that expect a number from 0 to 10, which indicates the resource’s capability to perform a particular skill (see page 29), are randomly generated favoring the lower numbers.

   In all cases, except Town Persons, no attempt is made to correlate the randomly generated items.

   In the Town Person case, the Title selected is consistent with the gender of the Town Person. The Years Of Residence is never greater than the Age of the Town Person. If the Town Person is not Employed then the Employer field is empty.

   Thus, this random method is not very intelligent, so it is possible to generate a resource that is an oxymoron, in which case the instructor should edit the entries.
Index

About Menu, 49
Add Comment To Table-Top Exercise, 40, 43
Add Image’s Filename To Table-Top Exercise, 41, 43
An Example Of A Table-Top Exercise, 59
Avoid Characters, 17–19, 21, 23, 25, 27, 29

Card
  Create For Element, 13
  Delete, 14
  Edit, 14
  For Instructor, 14
  Move, 14, 17, 18
  Print, 14
  Project, 13, 14, 30
  Remove From Table-Top Exercise, 43
  Save Table-Top Exercise To TeX File, 43
  Save To File, 14
  View, 14

Cards, 4
  An Example, 60
  Create/Edit For Clue, 16
  Create/Edit For Event, 17
  Create/Edit For Resources, 18
  Creating, 13, 16
  How To Add To Table-Top Exercise, 38, 43, 53
  Import To Element, 13
  Print, 73
  Print All From Element, 13
  Save All To TeX File From Element, 13
  Save All To TeX File From Element, 13
  Select For Exercise From Element, 13
  View All From Element, 13
  Cards Context Menu, 11–13

Cards panel, 8, 11
Characters
  Avoid, 17–19, 21, 23, 25, 27, 29
Check For Updates Menu, 49
Close Deck, 9
Clue
  Create/Edit Card, 16
  Description Box, 16
  Instructions Box, 16
Clues, 4, 11
Context Menu
  Cards, 11–13
  Elements, 11, 12, 53
  Project A Card, 30
  Timeline, 46
  View Exercise, 43
Create Card For Element, 13
Create Timeline, 38
Create/Edit Card For Clue, 16
Create/Edit Card For Event, 17
Create/Edit Card For Resources, 18
Create/Edit Scenario, 32
Creating Cards, 13, 16
Credits, 49
Customize Menu, 13, 16
Deck, 4
  Close, 9
Export Contents Of Folder, 9, 15
For Instructor, 9, 13
Open Existing, 9, 14
Print, 9
Rename, 9, 15
Save To TeX File, 9
Save To Text File, 9
Start New, 9, 10
View, 9
Delete Card, 14
Edit Card, 14
Edit Comment To Table-Top Exercise, 43
Elements, 4
   Context Menu, 53
Elements Context Menu, 11, 12
Elements panel, 8, 11
Event
   Create/Edit Card, 17
   External Emergency, 17
   External Influence, 17
   Find, 17
   Investigation, 17
   Logistics, 17
   Management Related, 17
   Medical, 17
   Resource Related, 17
   Search Related, 17
   Weather, 17
Events, 5, 11
Exit Menu, 8
Export Contents Of Deck Folder, 9, 15
   File Menu, 8, 9
   Firefighter Menu, 47
   Flashcards, 9, 13, 43, 73
   For Instructor, 9, 13, 14, 17–19, 21, 23, 25, 27, 29, 42, 43
Help Menu, 8, 49
Help Topics Menu, 49
History of SARDECK, 3
How To Add Cards To Table-Top Exercise, 38, 43, 53
How To Run A Table-Top Exercise, 68
How To Use SARDECK, 58
Image
   An Example, 61
   Import, 37
Image Viewer, 37
Images
   Print, 43
Images Menu, 8, 36
Import Cards To Element, 13
Import Image, 37
Installing SARDECK, 1
Instructor’s Comment, 17–19, 21, 23, 25, 27, 29, 42, 43
Introduction to SARDECK, 3
Keyboard, 2
Law Enforcement Menu, 48
Menu
   Context
      Cards, 11–13
      Elements, 11, 12, 53
      Project A Card, 30
      Timeline, 46
      View Exercise, 43
   Customize, 8
   Exit, 8
   File, 8, 9
   Help, 8
   Images, 8, 36
   Open Existing Deck, 8
   Scenario, 8, 32
   Start New Deck, 8
   Table-Top Exercise, 8, 38
Menu Item
   About, 49
   Check For Updates, 49
   Credits, 49
   Customize, 47
   Firefighter, 47
   Help, 49
   Help Topics, 49
   Law Enforcement, 48
   Ranger, 48
   SAR Team, 48
   Town Person, 48
Mouse, 2
Move Card, 14, 17, 18
Open Existing Deck, 9, 14
Open Existing Deck Menu, 8
Outline of SARDECK, 3
Panel
   Cards, 8, 11
   Elements, 8, 11
   Playbook, 42, 58
   An Example, 62
   Print, 42, 43
Save, 42, 43
Save To TeX File, 42, 43
View, 42
Print All Cards From Element, 13
Print Card, 14
Print Cards, 73
Print Deck, 9
Print Images, 43
Print Playbook, 42, 43
Print Scenario, 32, 33
Print Table-Top Exercise, 40, 42, 43
Print Timeline, 43
Project A Card, 13, 14, 30
Context Menu, 30
Project The Scenario, 30, 32
Random, 76
Ranger Menu, 48
Remove Card From Table-Top Exercise, 43
Rename Current Table-Top Exercise, 38
Rename Deck, 9, 15
Resource Factoring, 7, 18, 21, 23, 25, 27, 29
Resources, 5, 11
Create/Edit Card, 18
Firefighter, 18
Group, 18
Law Enforcement, 21
Other, 18
Ranger, 23
SAR Team, 25
Town Person, 26
Running SARDECK, 1
SAR Team Menu, 48
SARDECK
History, 3
How To Use, 58
Installing, 1
Introduction, 3
Outline, 3
Running, 1
Starting, 7
Uninstalling, 1
Upgrading, 2
SARDECK.sar, 2, 8, 10, 37, 73
Save All Cards To File From Element, 13
Save All Cards To TeX File From Element, 13
Save Card To File, 14
Save Deck To TeX File, 9
Save Deck To Text File, 9
Save Playbook, 42, 43
Save Playbook To TeX File, 42, 43
Save Scenario, 33
Save Scenario As A TeX File, 33
Save Table-Top Exercise, 42, 43
Save Table-Top Exercise Card To TeX File, 43
Save Table-Top Exercise To TeX File, 42, 43
Scenario, 3
An Example, 59
Create/Edit, 32
Print, 32, 33
Project, 30, 32
Save, 33
Save As A TeX File, 33
Skeleton, 34
Scenario Menu, 8, 32
Select Cards For Exercise From Element, 13
SETTLER, 3
Start New Deck, 9, 10
Start New Deck Menu, 8
Start New Table-Top Exercise, 38
Starting SARDECK, 7
Table-Top Exercise, 3, 38, 46, 59, 68
Add Comment To, 40, 43
Add Image’s Filename To, 41, 43
An Example Of, 59
Edit Comment To, 43
How To Add Cards To, 38, 43, 53
How To Run, 68
Print, 40, 42, 43
Remove Card From, 43
Rename Current, 38
Save, 42, 43
Save Card To TeX File, 43
Save To TeX File, 42, 43
Select Cards From Element, 13
Start New, 38
View, 38–40, 42
Table-Top Exercise Menu, 8, 38
TgX, 9, 13, 33, 46, 73
Timeline, 7, 44
Add An Entry, 45
An Example, 62
Context Menu, 46
Create, 38
Delete Entry, 46
Edit Entry, 46
Print, 43, 46
Save To TeX File, 46
Save To Text File, 46
Sort, 46
Town Person Menu, 48
Uninstalling SARDECK, 1
Upgrading SARDECK, 2
View All Cards From Element, 13
View Card, 14
View Deck, 9
View Exercise
  Context Menu, 43
View Playbook, 42
View Table-Top Exercise, 38–40, 42